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About NexSens Technology, Inc. 

NexSens Technology, Inc. was started in the 1990s with a mission to advance the capabilities 

and simplify the development of environmental monitoring systems.  Our main focus is on the 

creation of easy-to-use computer software and powerful communications technology to provide 

advanced remote data acquisition and data logging systems. 

iChart is an easy-to-learn, easy-to-use Windows-based software program designed to interface 

with the industry’s most popular environmental monitoring sensors and systems. A large multi-

vendor instrument library makes setup quick and easy.  iChart automates much of the tedious 

programming, data collection and manual data processing common with other environmental 

data collection systems. 

The NexSens iSIC (Intelligent Sensor Interface and Control) is a state-of-the-art line of data 

loggers that simplify the collection of real-time data from environmental sensors and monitoring 

instruments.  The iSIC data logger supports multi-vendor sensor connections and is designed for 

environmental data monitoring with NexSens communication equipment and software.  

Remote data acquisition systems have been developed specifically for unattended monitoring 

applications.  NexSens telemetry systems provide real-time access and 2-way communication to 

remote environmental monitoring systems via direct-connect, landline phone, radio, and cellular 

telemetry. 

About iChart Software 

NexSens iChart software is a data collection and analysis tool for environmental monitoring 

instruments.  It provides both a direct interface to RS232 smart sensors (ie. multi-parameter 

sondes) and an interface to the NexSens iSIC Datalogger.   

iChart is a user-friendly software package that eliminates the complicated programming required 

to operate traditional dataloggers and sensors.  Common sampling options such as log intervals, 

interrogation schedules, and sensor parameters are setup through easy to navigate dialog boxes 

and graphical menus.  iChart will automatically retrieve data from sensors directly connected to a 

PC, iSIC Datalogger, or NexSens telemetry system.  All data and sensor configuration settings 

are stored in a single iChart database. 

iChart includes a unique historical report creation tool that can generate customized reports with 

data from all sensors in an iChart database.  While creating a report, users can include specific 

information about the monitoring site, location, sensors, and project along with the recorded 

measurements from instruments.  After creation, reports can be converted to PDF, exported to 

Microsoft Excel, sent to colleagues via e-mail, uploaded to a web server, and more. 

iChart includes web data posting capabilities that provide access to sensor data over the 

Internet.  Users typically access their database through NexSens’ data hosting service 

www.WQData.com, but the option is also available to post the database to a personal web 

server.  WQData.com is very simple to use and iChart can be configured to upload data to it in 

minutes.  The user interface at WQData.com can display data in graphs and tables, and convert 

it to CSV format for download to a local PC. 

 



NexSens Technology, Inc. 

iChart Software Operations Manual 6 

How to Use This Manual 

This manual is designed to provide you with detailed instructions for interfacing specific sensors 

to the NexSens iSIC data logger.  

Important: Before attempting to interface a sensor with a NexSens data logging system, it is 

important that you have thoroughly read the operation manual(s) provided with your NexSens 

system and environmental monitoring sensor(s). 

This manual provides you with all the information needed to interface your sensor with the iSIC 

data logger.  For advanced system and sensor reference material: 

� Review the material in the iSIC operations manual: 

o http://www.nexsens.com/support/manuals.htm  

� Review the sensor manufacturer’s operations manual. This information should have been 

provided with the purchase of the sensor. This material can also typically be found at the 

instrument manufacturer’s website. 

� If you are still having difficulty, email your technical support question to:  

support@nexsens.com 

System Requirements 

iChart requires the following minimum system configuration: 

 

• Pentium class PC 

• 64 MB RAM 

• 100 MB hard drive space 

• 2MB video card 

• CD-ROM drive for software installation 

• Windows 95, 98, ME, NT4 (SP3 or higher), 2000 (SP1 or higher), XP 

 

For better performance and reliability, twice the minimum system configuration and WinNT4 

(or Win2000) are recommended.  If you are communicating with a NexSens 2100 Field 

modem, we recommend that you use an external modem with a Rockwell (Conexant) 

chipset.  If you are communicating with a NexSens 3100-iSIC Cellular modem, we 

recommend that you use a PC with access to a broadband Internet connection (ie. cable, 

DSL, T1). 
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Software Installation 

iChart is distributed on CD-ROM.  The setup program starts automatically when the CD is 

inserted.  If not, you can manually start the setup process by following the steps below.  We 

suggest that you accept the default options presented by the iChart setup program. 

 

Double click My Computer.  

Double click the CD-ROM drive to open iChart CD.  

Double click Setup.exe or Setup icon to start the installation program.  

 

During the installation, you will be asked to register iChart software.  You can either print the 

registration form and mail or fax it to NexSens or connect to the Internet and register online.  By 

registering within 30 days of purchasing iChart, you are eligible for 2 years of free software 

updates. 

 

After installation is complete, you can run iChart from the start menu Program|NexSens| 

iChart.  For your convenience a shortcut to iChart is also placed on your desktop. 
 

Important Notice 

Managing your environmental data and information is a formidable task.  iChart simplifies this 

effort and organizes your important data.  Be sure to backup your database and other important 

files on a regular basis.  To help you with this, iChart has automatic backup and remind-me-to 

backup features. 

See Backup and Restore for details. 

Uninstalling Software 

To uninstall iChart, click Settings in the Start Menu. Select Control Panel and then Add / 

Remove Programs and select “iChart5”. Follow the instructions to remove iChart and all 

associated files.  
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1 What is iChart? 
 
iChart is an advanced and highly graphical user interface for a large number of environmental 

sensors from an assortment of different vendors. At its core, iChart consists of four main 

features: graphical instrument control, powerful data reports, virtual display basemaps, and 

internet data posting.  

1.1 Graphical Instrument Control  

An environmental monitoring tool must be powerful and easy to use. iChart has an intuitive and 

fully integrated workspace interface.  The built in navigation panel makes it easy to select 

between various iChart views: Basemap, Virtual Instrument Control and Report. 

iChart automates much of the tedious programming required with other data logging systems.  

Simply point and click on options in dialog boxes and your iSIC data logger is setup and ready to 

begin collecting data. 

 

Key Features: 

• Easily navigate-able 

• Extensive Multi-Vendor Library 

• Highly graphical user interface 
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1.2 Powerful Data Reports 

Many environmental professionals find themselves at the end of a project crunching numbers 

and paging through reams and reams of data. iChart's built-in report generator simplifies the 

entire process.  You can quickly generate reports to include data tables, statistics and plots. Best 

of all you can set iChart to generate these reports automatically.  Months of data can be 

compressed to statistical summaries or daily averages.  iChart makes it easy!  

iChart also offers a 'one- button' export to Microsoft Excel or Adobe PDF. Simply highlight the 

data of interest and click either the Excel or PDF icon on the main toolbar. The program will be 

launched and the data will be inserted into a spreadsheet or PDF file. Features such as 'one-

button' export, simplify your job and improve your productivity! 

  

Key Features: 

• One button export 

• Automatic report generation 

• Powerful graphing and data analysis capabilities 
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1.3 Virtual Display Basemaps 

In addition to plots, data tables and statistics, iChart has a complete library of virtual displays 

and controls to provide visual representation of your data. Temperature can be displayed on a 

traditional mercury thermometer, or wind speed and direction on a wind dial and rain in a 

graduated cylinder.  

Add an aerial photo to your iChart database. Data from sensors can be accessed simply by 

clicking on their location in the photo. Data presentations are easy with an aerial photo in your 

iChart database. You can use an aerial photo to display the exact location of instruments and 

dataloggers. 

See the big picture with iChart. Create a custom basemap and place data source objects on your 

display. iChart will keep your display up to date with the latest data and notify you if the site is 

down. 

 

Key Features: 

• Pre-built components already designed, simply select a thermometer to add it 

• Full feature set of picture editing capabilities 

• Ability to show real time data as iChart receives it from sensors 

• Easily customizable to your specific application 
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1.4 Internet Data Posting 

Online data is becoming the key component of most real-time environmental monitoring 

systems. iChart software can setup a fully featured datacenter for you, eliminating all the 

website development normally required to create a useful online interface.  View data in graphs, 

data tables, or simply download it for further offline analysis. iChart makes this easy.  All you 

need is a web address, user name and password. 

 

Key Features: 

• Setup and view an online database in just a few minutes 

• Ability to view data in graphical or tabular format 

• Ability to download an analyze data in Microsoft Excel 

• Easily filter and control what data is presented to users 

• No IT staff or web knowledge required, iChart automatically generates the website for 

you! 
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2 Getting Started 
2.1 Installing iChart 

 

After either running the iChart installation from 

a NexSens CD or from the NexSens website 

the iChart Setup dialog box will appear. 

 

Click Next to continue. The NexSens License 

Agreement will appear. This agreement is the 

same as the one that appears at the beginning 

of this manual. 

 

Next, iChart Setup will ask you to choose which 

folder to install the iChart program to. It is 

highly recommended that this folder be left  
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iChart will display the selected settings. Click 

Next to continue. 

 

 

 

iChart Setup will then begin installing. This 

may take a few moments depending on the 

speed of your computer. 

 

 

Finally, click Finish to complete the installation 

of iChart. 
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2.2 Registering iChart Software 

iChart will run for 30 days before it requires registration. During the 30 days, click Continue to 

run the program. Before the time expires iChart will need to be registered. Run iChart and click 

Register. The following screen will appear: 

 

Enter your name and organization and registration key in to the appropriate fields. Simply visit 

http://www.nexsens.com/register.php and fill out the form to obtain a Registration Key. 

This form can also be accessed by selecting “Help | Register iChart…” in the software. 
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2.3 Running iChart For The First Time 

By default the iChart 6 icon is located on your desktop. Double click on this icon to open iChart 

software. The following screen will appear:   

 

This is the iChart Open Choice menu. From this menu you can perform a variety of tasks as 

detailed in the following pages. 

Open Sample Project  

This option will open a sample iChart database. This allows to you to see all of what iChart is 

capable of. This sample database includes a basemap and several sensors. You will not be able 

to interrogate these devices, but you will be able to have the look and feel of an iChart database. 

An iChart Quick Tour pop up guide will walk you through the main iChart features. It is 

recommended for all first time users to go through the tour to get a feel of how iChart operates 

and a general overview of its features. 
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Open Last Project  

This option will open to the last iChart database used.  

Create New Project  

This option will open directly to the iChart Project File menu.  

 

Enter a filename for the iChart database and click Save.  This is the “iChart Database 

Configuration” file and it contains the setup information for all sensors and iSIC Dataloggers in 

the database.  By default, the file is located in the folder: C:\Program 

Files\NexSens\iChart6\Users and has the extension .ICR.   

This window can also be opened selecting New Project from the File Menu, or by clicking the 

New Project icon from the Main Toolbar 

Open Without Project  

This option will open directly to iChart without a database open. You can then create a new 

database by selecting New Project from the File Menu, or by clicking the New Project icon 

from the Main Toolbar. This will open the Create New Project window. 

 

 

 

 

 

The Open Option window can be disabled so it does not come up at the start of iChart. You can 

re-enable this window by going to Edit | Preferences and then placing a check next to the 

Enable startup dialog box. When the Open Option menu is disabled, iChart will open by 

default to Open Last Project. If an iChart database has never been opened, then iChart will 

default to Open Without Project. However, you can choose which items you would like to 

auto-load when starting iChart from the Edit | Preferences menu. 
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2.4 Keeping iChart Up to Date 

From time to time NexSens will release new versions of iChart software as well as iSIC firmware 

that adds new features, expands on old ones, or adds more reliability to the system.  

To obtain the latest versions of software and firmware, in iChart, go to Help | 

Check for Updates: 

iChart will check the NexSens website for a more up 

to date version of software. If you are running the 

latest version iChart will let you know.  

However, if there is a newer version of iChart available a dialog box will appear asking if you 

would like to upgrade to this version. 

  

If you click Yes, iChart will begin downloading the update. Please note that depending on your 

connection speed, this update may take a while. Feel free to do other things on the computer 

while the download is progressing. 

 

When it has finished downloading, simply click OK, and restart iChart. When iChart restarts it will 

begin the installation process. Click Next to install iChart. 

 

After following the installation windows, iChart will be successfully updated. 
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3 Adding Devices to an iChart Database 
An iChart database contains more than just data retrieved from sensing devices.  It contains 

configuration settings for sensors, data reports, web posting, basemaps, and more.  A single 

iChart database may be used to interact with many sensors and data loggers, and acts as a 

“control center” for your entire environmental monitoring network.   

The following tutorials will explain the process of creating a new iChart database and adding 

devices to it.  No programming is required to add devices to the database.  All setup is done 

through a series of easy-to-use dialog boxes.  Instructions for setting up specific sensors can be 

found in the NexSens iSIC Data logger User’s Manual. 

iChart contains many “device drivers” for popular environmental monitoring sensors that 

communicate with data loggers and PC’s via RS232.  These device drivers have been created by 

NexSens’ software engineering team and eliminate the need for you to write a separate software 

program that parses the serial output data stream.  This tutorial will explain the process of 

adding an RS232 multi-parameter water quality sonde from YSI to an iChart database. 

Step 1 – Create a New iChart Database 

 

Create a new iChart database by selecting 

New Project from the File Menu or by 

clicking the New Project icon from the Main 

Toolbar.  

 

 

Step 2 – Choose a Filename for the iChart Database 

A dialog box will appear asking for the iChart database filename.  Enter a filename for your 

database and click the Save button to continue. 
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Step 3 – Select a Site  

The Setup Device Wizard dialog box should come up.  Click Next to continue.  Enter your site 

name and description and then click Add to add the site to your project map.  Once the site 

appears in the main box, click Next to continue or add more sites as needed.   

  

Step 4 – Select Data Logger and Telemetry 

 

You can name your data 

logger and add a description 

at the bottom.  Then select 

the site to add a data logger 

to, pick the data logger 

corresponding to your project, 

site and telemetry and click 

Add.   
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Once the Add button is pressed, the 

communication properties dialog box 

appears for the iSIC being added.  In 

this box, the iSIC being talked to can 

be changed in the iSIC address field.  

The default address for an iSIC is 1 and 

to broadcast the address is 0.   

If the iSIC is directly connected to the 

PC, the port and communication details 

can be set in the “Dirct PC Connection” 

box.   

The connection can also be tested with 

the Test Connection button.   

Press Ok when finished.   

 

 

Along with testing the connection, the 

Test Connection button will also show 

iSIC address, ID, firmware and 

hardware versions, iSIC time and 

battery voltage.   Press Close when 

finished.   

 

Multiple data loggers can be added in 

this fashion.  Click Next when all data 

loggers have been added.   
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Step 5 – Choose Your Sensor(s) 

Select the manufacturer of the sensor from the drop down menu on the right.  Once the 

manufacturer is selected, choose your sensor model from the scroll list below the drop down 

menu.    

 

Once the sensor is highlighted, click Add to go into sensor properties.    

 

Add the desired parameters 

to the selected list.  The order 

of the parameters on the 

selected list is the order the 

parameters show up on the 

screen.   

When each parameter is 

selected, the display units can 

be chosen from the buttons in 

the bottom left corner of the 

dialog box.   

The port can be chosen and 

tested in the upper left of the 

dialog box.   
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Click Ok to finish adding the sensor.    

 

Once the sensor has been added, it should show the sensor under the selected site and logger.  

Repeat as needed to add more sensors to your project.  Sensors can be moved between sites by 

selecting and using the Up and Down buttons to move to the desired site.   

Step 6 – Input/Output 

To enable the maintenance switch select a data logger, check the box and select the port the 

switch connects to.  Press Next to continue.   
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Step 7 – Log Options 

Select the log interval, sample interval and log type for each logger.  Then click Next to 

continue.   

 

Step 8 – Program and Finish 

Complete the process by selecting each data logger and then pressing the ‘Program iSIC’ button 

to program data logger.  Once all the loggers have been programmed click on Finish.  Click on 

the “ + ” buttons to expand the tree and display the list of monitoring parameters available in 

the sonde.  Double-check and confirm that all desired parameters have been enabled.  Click OK 

to add the sensor to your iChart database. 
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Step 9 – Retrieve an Initial Data Set and Use the Instrument Within iChart 

After your sonde has been added to the database the following screen will appear:  

 

Please note that all parameters are initially displayed with values of dashes (---.--).  Once data 

has been retrieved from the sonde these fields will show the most recent data set recorded by 

the instrument.  Click the Interrogate button to retrieve data from your sonde. 
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4 Working With Devices 
4.1 Adding Devices to the iChart Database 

iChart databases may contain hundreds of individual monitoring devices and sensors.  Add 

additional monitoring instruments to the database by selecting the Setup Device Wizard 

command from the Project menu.  From here you can add a new device using the same 

process outlined in Chapter 3 – Adding Devices to an iChart Database. 

 

All current sites, data loggers and sensors should already be shown.  Devices can be moved 

using the Up and Down buttons.  Don’t forget to program new data loggers or if sensors have 

been added to a data logger.   

4.2 Disabling Devices in the iChart Database 

Devices can be disabled within the iChart database.  This feature will prevent iChart from 

interrogating the sensor and retrieving any new data from it.  Typically this option is used when 

a device is inactive due to regular maintenance requirements or has been physically removed 

but will be re-deployed at a later date. 

To disable a device, first right click the device sensor or specific parameter from the Navigation 

Panel and then select the Disable command. The Disable option will only be displayed if the 

device selected is enabled. Devices are enabled by default. 
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After you have selected Disable Device, iChart will ask you if you would like to add a field note 

stating that you have disabled this device with the time that you disabled it. A field note is a note 

that is located in the Summary section of Report. See section 7.7.5 for more information on 

field notes.  

 

Select Yes if you would like to open the Field Note message box. Select No to simply return to 

the Instrument Control screen.  Once a device or parameter is disabled, the parameters will be 

grayed out in the main display.   

 

4.3 Enable Devices in the iChart Database 

Disabled devices can be re-enabled by first selecting the device or parameter from the 

Navigation Panel and then selecting Enable command.  The Enable option will only be 

displayed if the device selected is disabled. 
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After you have selected Enable, iChart will ask you if you would like to add a field note stating 

that you have enabled this device with the time that you enabled it. See the section 7.7.5 on 

field notes for more information. 

 

Select Yes if you would like to open the Field Note message box. Select No to simply return to 

the Instrument Control screen. 

4.4 Renaming Devices in the iChart Database 

Once a device has been added to iChart, it will be displayed in the Navigation Panel.  The text 

shown for the device in this list is determined from your input when the device was added to the 

database.  To change this description, click on the device, then click again on the text to go into 

a rename text box.   

 

To rename a site you can follow the same process as renaming a device.  Also you can right click 

on the site name, go in to Property and then enter the new name in the Site name field.   
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4.5 Retrieve Data From Sensors 

Data is retrieved by the process of “interrogating” each sensor in the iChart database.  Sensor 

data may be downloaded manually by clicking the Interrogate button, or users can configure 

an automatic “interrogation schedule” through iChart. By default a one hour automatic 

interrogation schedule is set. This means that at the beginning of every hour, iChart will 

automatically interrogate every sensor in the database. 

To manually interrogate sensors, click the Interrogate button as shown below: 

 

If you would like to automatically retrieve data at an interval other than one hour, simply change 

the auto-interrogation schedule. 

The auto-interrogation schedule is located within the schedule dialog box in iChart by clicking the 

Schedule button as detailed in the following section. 
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4.6 Set an Auto-Interrogation Schedule 

iChart can be configured to automatically interrogate devices and retrieve data on a user-defined 

schedule.  Set an Interrogation Schedule by clicking the Schedule button on the main 

instrument control screen.  

 

iChart will interrogate the device on 

the days indicated.  Place a check in 

the box for the days you wish to 

retrieve data.  To interrogate the 

sensor every day of the week, select 

each box as shown in the screenshot. 

iChart will interrogate the device one 

time during the interval specified in 

the Every ? Minutes field.  For 

example, if this field is set to 60 

minutes, iChart will interrogate the 

device once an hour. 

 

 

iChart can be prevented from interrogating the device outside the times indicated in the 

Between ? and ? fields.  When these fields are left at their default values iChart will interrogate 

the device during all hours of the day. iChart will only interrogate between the times specified in 

these fields. 

If you would only like to interrogate at specific times throughout the day, click the At field. Up to 

four specific times can be set in the At field. If a time is set in one of these fields, iChart will only 

interrogate the device at that time. 

Some sensors (ie. multi-parameter water quality sondes) require a certain amount of warm-up 

time before taking measurements.  Enter an Offset (in seconds) in this field to force iChart to 

wait for a period of time before interrogating the device. 

To disable automatic interrogation, uncheck the box next to Enable. This box is checked by 

default. 

4.7 Pausing and Un-Pausing Auto-Interrogation 

During some situations it may be necessary to prevent iChart from automatically interrogating 

devices in the iChart database.  Interrogation can be paused by selecting the Pause Auto-

Interrogation command from the Project menu.  Resume automatic data retrieval by selecting 

the Unpause Auto-Interrogation command.  
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4.8 Setting Up and Using iChart Alarms 

iChart software allows you to create alarms when certain parameters go above or below a 

designated value. For example, let’s say you are in charge of monitoring the water quality at a 

fish farm. Why not have iChart send you a text message on your cell phone if the dissolved 

oxygen gets too close to critical levels. Using alarms allow you to be warned immediately when a 

situation is about to occur!  

iChart allows you to: 

1. Generate a sound on the computer speaker 

2. Flash a warning message on the computer 

3. Play a specified .wav file 

4. Send an email message 

5. Create a text file 

6. Send a text message to a cell phone 

7. Trigger an ISCO sampler to take a sample 

 

iChart allows you to use two different kinds of alarms: iChart or iSIC based.  

iChart Alarms: 

 

Every time iChart receives data from a device it checks to see if the values of that data exceed 

an alarm threshold. If it does, an alarm will activate.  

PC Alarms allow you to have a certain event occur whenever a parameter goes above or below a 

certain point. From the Navigation Panel select the device you would like to have an alarm for. 

Then in the main instrument control screen, click the Setup iChart Alarm from the Project 

menu.  Now select the parameter you would like to set an alarm for.  

From here you can either enable a high alarm, a low alarm or both, just click the enable button.   

The Set Point is the value you want the alarm to trigger. For example click on Temperature C 

on the left hand column and enter 50 for the Set Point. This means that if the temperature goes 

above 50oC, an alarm will occur.  
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The Reset Point is the value at which the alarm will allow it to trigger again. For example; if the 

temperature went above 50oC an alarm would occur just once. If the Reset Point is set to 45oC, 

and the temperature drops down below 45oC then the alarm will occur again if the temperature 

goes above 50oC again.    

The Reset Point is important so that the alarms can occur if the situation happens at different 

occasions. It is safe to set the Reset Point a little bit below or above the value as the Set Point 

such as a Set Point of 50 and a Rest Point 49 for a High Alarm. This prevents iChart from 

triggering an alarm over and over if the parameter is at the edge. The Alarm Actions are the 

specific alarms you would like to occur. See the following pages for information on each of these. 

Click on the ‘…’ button located on the far right of the Alarm Action field. 

 

A window will appear that allows you to select the type of alarm you would like to use. Click on 

the drop down menu and select one of the following alarms. After you have set up the alarm 

action you can go back and setup the second alarm or  

 

Acknowledging an Alarm 

When ever an alarm triggers, an Alarm Toolbar will be displayed. This tool bar allows you to 

acknowledge the alarm, and stop it from carrying out until the reset point is reached. Click on 

the picture of the speaker with a red circle to end the alarm. 

 



NexSens Technology, Inc. 

iChart Software Operations Manual 32 

Generate a sound on the computer speaker 

 

Selecting Sound PC speaker will generate a continuous 

computer beep until the alarm is acknowledged. 

 

 

Flash a warning message on the computer 

 

 

Selecting Flash message will flash the message 

specified in the Message field until the alarm is 

acknowledged. 

 

 

Play a specified .wav file 

 

Selecting Play wave file will continuously play the 

specified wave file until the alarm is acknowledged. 

Specify the wave file by clicking the ‘…’ located to the far 

right of the Wave File field. 

 

For your convenience, a few wave files are located in: 

C:\Program Files\NexSens\iChart5\System 

Simply select one of the .wav files that you like. You can 

test these file before hand or download your own alarm 

from the internet. 
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Send an email message 

 

Selecting Send email message will send an email to 

the specified email address in the Email Address field. 

The subject line of the email is “ALERT”. And the body 

text is the text entered into the Message field. A new 

email will not be sent on alarm until the reset value has 

been reached. 

Note: your email information must be correctly 

setup in the ‘Edit | Preferences’ menu for this 

alarm to work properly. 

Create a text file 

 

Selecting Create File will create a text file with the 

designated File Name and with the text body of 

Message field. This file is saved in the current selected 

folder. By default this is:  

C:\Program Files\NexSens\iChart5\ 

If you want to save the file in G:\Temp\ simply enter 

“G:\Temp\warning.txt” in the File Name field. 

A new file will not be saved on alarm until the reset 

value has been reached.  

Send a text message to a cell phone 

 

Selecting Send SMS message sends a text message to 

the cell phone number designated in the Phone 

number field. The text message is the text set in the 

Message field. 

A new text message will not be sent on alarm until the 

reset value has been reached. Note: text messaging 

must be enabled by NexSens Technology before use. 

Trigger an ISCO sampler to take a sample 

 

Selecting Trigger ISCO sampler will make a 67xx 

sampler take a water sample when this alarm 

triggers. The sampler will place that water sample in 

the bottle number specified and sample the amount 

of water specified in the volume field. 

 

Note: an ISCO sampler must already be setup in your 

iChart database for this alarm to work. If more than 

one ISCO sampler are in the database, this alarm will 

use the first one. 
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iSIC Alarms: 

If you are using a 3100-iSIC with SMS messaging capability, you can use what is called an iSIC 

Alarm. This is an alarm the iSIC sends. Click the Enable iSIC alarm button after clicking Setup 

from the Device dialog box and switching to the iSIC Alarm tab, and then every time the iSIC 

gets data from a sensor (every log interval), the iSIC will check to see if the value it receives for 

the Parameter field from the sensor meets the Condition field with the Value field. If it does for 

the number of times in the Count field, the iSIC will send a text message to the phone number in 

the Phone Number field.  

By default the text of the text message with state  

“ALERT: <either High or Low> <Parameter> <Parameter Value>” 

This message can be edited by clicking the “Edit message format string” button. 

Click Update iSIC after you have setup the alarm the way you would like to program the iSIC to 

perform the alarm tasks. 

 

It should be noted that in order for this capability to work you must use a phone that has a SMS 

text messaging service. If you are unsure, simply contact your phone service provider.  
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4.9 Monitoring Critical Projects 

 

Due to the nature of many environmental 

projects, immediate notification of 

failures is a necessity for many project 

managers. The iChart System Monitor 

allows a project manager to receive 

critical messages such as failure to 

retrieve data or upload data online. 

 

 

The Status tab of the System Monitor 

sets the schedule the iChart project 

status information should be emailed 

(Note: an email server must be setup in 

Edit | Preferences for emails to be 

sent). This email includes information 

such as what devices are enabled or 

disabled, if iChart is currently closing, and 

if auto interrogation is on or off. 

 

 

The Alert tab of system monitor sets the 

schedule and conditions iChart will send 

an alert email. These conditions include 

auto interrogation failures, data not being 

up to date, failure to post data online, 

and the reporting of any error codes in 

the data, such as missing or out of range 

values. 
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5 Working With Data 
5.1 Creating Historical Data Reports 

Data may be presented in one of three ways within an iChart report – Statistics, Graph, and 

Table.  In addition, users may also include information specific to the report such as the physical 

location of a sensor and name of the monitoring project.  Users can choose which modes to 

include in a report – simply turn off the modes that you wish to hide. 

 

To configure an iChart data report, use the integrated Report Tools.  The Report Tools are spread 

across four tabs located on the bottom of the Report Toolbar – General, Graph Properties, 

Output, and Advanced.  

The report interface in iChart is fully interactive and changes to reports are displayed instantly.  

By default, iChart will generate a daily report and display data from the first monitoring 

parameter in statistic and graph format.   
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To include additional parameters in the report, double-click a folder 

icon.  This action will expand the list of parameters for that 

particular sensor.  Place a check in each box next to the desired 

parameters.  

Please note that once a new parameter is selected, the report will 

update instantly.  Depending on the amount of data in the 

database, there may be a small pause.  Wait for iChart to update 

the report before selecting another parameter. 

In addition to selecting which parameters are reported, iChart allows you to fully customize all 

other aspects of the report: 

 

iChart includes standard templates for daily, monthly, and 

yearly reports.  In addition, reports containing the entire 

database may be generated.  Select these options in the “Time 

Limit” section of the Report Toolbar.   

 

 

iChart will display data in statistic, graph, and table formats.  

Statistics include the average, minimum, maximum values, 

and standard deviation of each parameter.  Check the “Data” 

box to display data in that table format.   

 

 

iChart allows you to auto-align data based on time. This 

feature is very useful when generating reports using multiple 

sensors that do not necessarily have the same time interval 

between data points. By default, no data alignment is selected. 

If you would like to align data to minute intervals, simply 

select UserDefined and enter the number of minutes you 

would like to align the data to. 

 

In addition, reports can be exported to Microsoft Excel or converted to PDF and saved in a local 

folder.  Options are available for automatic report generation, sharing of reports via e-mail, FTP, 

folders, and more. 

Click the PDF icon on the Main Toolbar to output the current data report in Adobe 

Acrobat PDF format.   

Click the Excel icon on the Main Toolbar to output the current data report in Microsoft 

Excel format. 

iChart contains many more advanced features related to the Historical Data Report tool.   

 



NexSens Technology, Inc. 

iChart Software Operations Manual 38 

5.2 Automatic Historical Data Report Creation and Sharing 

iChart software is a data collection and analysis tool, designed to collect and store environmental 

measurements from remote sensing devices.  As such, historical report creation is one of the 

core components within iChart software.  Create a new historical data report by selecting the 

New Report command from the Report Menu or simply click the New Report icon from the 

Main Toolbar. 

  

 

Report creation tools in iChart software are fully interactive, and changes to a report’s settings 

are displayed instantly.  Report Mode is divided into two main sections.  The data report is 

displayed in the middle of the screen in HTML format.  The Report Toolbar is located on the 

right of the screen.  This toolbar contains all the functions used to create a historical report. 
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Report Output Destination and Format 

 

iChart can output reports in CSV (comma-separated value), PDF, and IDB (iChart Database 

Backup) format.  CSV reports can be opened using popular spreadsheet programs such as 

Microsoft Excel.  PDF reports are opened using Adobe Acrobat Reader.   

Click the Output tab  of the Report Tools to define the report’s 

Output Format and Destination. This tab is located at the bottom of 

the Report Tools menu.   

Check the Enable Auto Report field to enable the auto report 

feature. 

iChart can then be configured to generate reports and send them to a 

specific destination.  By default, iChart will simply display the report 

on your PC monitor once it is created.  Options are available to send 

reports directly to your PC or LAN folder, e-mail address, or an FTP 

server. 

To send a report to a PC or LAN folder select Folder from the 

Destination drop down menu. Next click on the “…” button, and 

browse to the folder location you would like the reports to be saved. 

To send a report to an e-mail address, select Email from the 

Destination drop down menu and enter the target recipient in the 

address field.  Send the report to multiple recipients by placing a 

semi-colon after each e-mail address in the field.  

To send a report to an FTP server, select FTP from the Destination 

drop down menu and enter the server’s URL in the field. For example, 

ftp://www.myftp.com.  Enter the username and password used for 

server login in the indicated fields.  

You may also have iChart send reports to your computers default printer. Select Printer from 

the Destination drop down menu.  

iChart can save the reports in CSV, PDF, or IDB format. Select the type of report you would like 

to auto-generate. 

If the Use fixed file name field is checked, the file name of the report will be saved as the 

name entered into the blank field below the check box. Keep in mind that iChart will 

automatically write over the previous report with the newly generated report if this feature is 

used. 

Note: IDB is a custom format, designed specifically to hold a portion of the iChart database.  If 

this output format is selected, the IDB can be opened directly in iChart through the Restore 

command found in the File Menu.   

You must set an Auto Report Schedule before iChart will begin automatically generating reports. 

See the following section for details creating this schedule. 

Note: All information entered into the Report Tool menus will not be saved until the user clicks 

on another menu. 
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Automatic Report Schedule 

 

A common application for iChart is the automatic creation of historical reports when the PC has a 

real-time connection to an environmental sensor.  iChart can be configured to generate data 

reports on a user-defined schedule and save them in a variety of locations. 

Click the Output tab of the Report Tools to define an automatic report generation schedule.  

Check the Auto Report Enable box to enable automatic report generation. You must then set 

the Auto Report Schedule to have iChart automatically generate reports at the given times. 

iChart will generate reports only on the days indicated by the 

Day drop down menu. By default, no days are selected. Place a 

check in the box for the days you wish to create new reports.  To 

create reports every day of week, select each check box as 

shown. The drop down menu will then display an abbreviation of 

every day selected in its drop down menu bar. For example, if 

Sunday and Monday are selected, then it will show Sun, Mon. 

 

You will then need to set up the frequency intervals that the 

reports will be generated. iChart has two different types of 

frequency intervals: periodic and fixed times. 

If you would like iChart to generate reports periodically, then click 

on the circle next to the Every ? Minutes drop down menu. You 

can configure iChart to generate a report at minute intervals 

specified by the Every ? Minutes field. Simply enter the number 

of minutes you would like to be between each generated report.  

For example, if this field is set to 60 minutes, iChart will update 

the report once an hour. 

You can also specify the allowable times iChart can generate 

reports. iChart can be prevented from interrogating the device 

outside the times indicated in the Between ? and ? fields.   

When these fields are left at their default values iChart will 

interrogate the device at every interval specified by the Every ? Minutes field. This feature is 

useful when the device is only on during certain times or if you would only like to interrogate 

during the day.  

If you would like iChart to generate reports at fixed times, then click on the circle next to the At. 

You can configure iChart to generate a report at specific times throughout the day, determined 

by the At fields. Up to four specific times can be set in the At field. iChart will only interrogate 

the device at that time.  

Enter an Offset (in seconds) in this field to force iChart to wait a specified length of time 

before updating the data report. For example, if you would like iChart to wait 5 minutes after the 

hour to generate a report, enter 300 into this field. 
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More Report Options 

Additional report options are available in the Report | Other Setup screen.  

 

This window will allow you to: 

1. Change the unit of measurement of a parameter for this report 

2. Allow you to display the data table in descending order (last reading 

on top) 

3. Allow you to create interval reports (ie. Last 30 days (September 18th to 

August 18th), instead of last month (September 18th to September 1st). 

 

 

The first tab of Other Setup is the Unit tab. Here 

you can select the parameter you would like to 

change the unit of measurement for from the menu 

under Parameter. Then on the right, select the new 

desired unit of measurement. Note: this unit change 

only affects the current report. 

The second tab of Other Setup is the Misc tab. Here 

there is a checkbox for if you would like the report 

data table to display the data in descending order 

(last reading on top). Additionally you can change the 

type of report that is generated. By default, Current 

is selected.  

 

Fixed means whatever time period you have selected 

for the report, the report will always use that time 

period. So if you made a report with a time limit with 

the current month of data, next month this report 

would still be of last month. 

Current means that whatever time period you have 

selected will be based on the current time. For 

example, if you select month as the time limit the 

report will always show the current month. So this 

month the month time limit will show this months 

data and next month this report would show next 

months data. Note: these changes only affect the 

current report. 

Previous means the report will always show the previous interval to what you have selected. So 

if you have month as the time limit the report will show last month. 

Interval means it will always show the last interval. For example if you have month selected it 

will show the last 30 days. If you enter 9/18/2006 in the To field and 9/16/2006 in the From 

field it will always show the last 2 days of data in this report. This feature is useful in auto 

generated reports where you always want to show the last xxx days of data in the report. 
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5.3 Using Basemaps 

Base maps are graphical views of your physical system. They are easily created with custom 

images and controls that come pre-made in iChart and only need to be positioned on the screen. 

Thermometers, wind dials, digital read outs, as well as links to data reports, are only a few of the 

controls that are available.  It should be noted that no artistic talent or programming required 

when using these features. 

 

New Basemap 

 

To create a new basemap, select New Basemap from the Basemap menu. 

  

iChart will then ask you for a basemap name. Enter a descriptive name and click OK.  

Base map Tools 
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After you have created a basemap, you will need to add background color of 

images, graphical displays, or links to reports. Basemap tools allow you to 

edit your base map displays.  The basemap tools can be hidden or displayed 

using the edit button  in the main toolbar.   

This section will briefly explain a few of the basemap features. Each item of 

the tool set is explained in chapter 7, please refer to the Basemap Tools 

section for more information.   

 

 

 

 

 

 

First we will add a background image. Click the Background Image icon and a 

dialog box will appear. 

Browse for the file you wish to open, select it, and click open. That image will now be displayed 

as the background to your new basemap. 

 

Next, click on one of the display icons, such as 

the thermometer . A dialog box will 

appear. Select the parameter you wish to 

display. You can also select the minimum and 

maximum value to be displayed by the display 

item. When you have finished, click OK. 
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The display object will appear on top of your background image. Note: the reading will not 

update until the basemap has been saved. This is accomplished by clicking on the basemap tool 

icon again.  

 

 

 

 

To add a link to your basemap, click the Datasource Object button . Select the 

image for your link from the drop down menu and place it on the basemap. 

 

 
 

 

A Control Object Property dialog box will 

appear.   

These features are used to control the actions 

executed when clicking on a link.   

 

 

Data Source Link – From the drop down menu, select the device you wish to link your link object 

to. All devices in your database will be listed. Select Interrogate from the Default Left Mouse 

Action section. Whenever this link is click on, iChart will interrogate the specified device. 

Report Link – Click browse and select the report you wish to link to.  Reports are found in 

*.Report folders located in C:\Program Files\NexSens\iChart5\Users. Where * is the name of the 

database. Select Report from the Default Left Mouse Action section. Whenever this link is 

clicked on, iChart will open to the report specified here.   

Custom View Link – From the drop down menu select the basemap you wish to link your link 

object to. All basemaps in the project will be listed. Select View from the Default Left Mouse 

Action section. Whenever this link is click on, iChart will open to the basemap specified here. 
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5.4 Using iChart to Store Data using ODBC 

While iChart has its own database format and a set of rich web and reporting tools, some users 

may prefer to use their own custom database to store the data or need to use an existing 

database to store the data. As long as the database you use is ODBC compatible you can have 

iChart store all sensor data into your database using a standard Windows ODBC connection. 

More information on ODBC databases and connections can be obtained here:  

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/odbc/htm/dasdkodbcoverview.asp 

 

You can access the ODBC menus from Project | 

ODBC. 

If you have not set up an ODBC database before, you 

will be prompted with a dialog box asking if you would 

like to setup a new ODBC connection. Click Yes. 

Open Database simply opens the connection to the 

database for which ODBC has been configured for in 

the Setup ODBC. 

Close Database simply closes the connection to the 

database for which ODBC has been configured for in 

the Setup ODBC. 

Setup Database  

 

If you would like to use a File Source ODBC database 

then browse for the File Source ODBC database you 

would like to use. Click on the New button if you do 

not have one. Refer to your windows ODBC driver 

documentation for instructions on how to create and 

configure ODBC connections.   

 

 

If you would like to use a Machine Data Source ODBC 

database then click on the New button and then on 

the Machine data source tab.   Select the Data 

Source from the list and click OK. 

Click on the New button if there is not an ODBC 

database available, or if the one you want is not listed. 

Refer to your windows ODBC driver documentation for 

instructions on how to create and configure ODBC 

connections. 
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5.5 Importing Data 

iChart can import csv files. You may already have the data in that format, or in another type of 

database. Most databases supply some form of data export to csv. 

The best way to format a file is to open Microsoft Excel© and use it to create a new spreadsheet. 

This will eliminate any erroneous formatting (such as graphs, etc) that may be left over in the 

current spreadsheet. Simply copy and paste columns from one spread sheet to the other. 

The spread sheet must be formatted with Date & Time in the first column, followed by the 

parameters in each successive column. There also needs to be a three row header before the 

data starts. This can be used to hold user information and any labeling you would like. The 

information contained in these three rows is not used by iChart. 

 

One thing to note is that the Date & Time must be formatted as: 

• month/day/year hours/minutes (mm/dd/yyyy hh:mm) 

iChart stores time in UTC format and is therefore unable to process data from before January 1st 

1970.  
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You can format the date and time correctly by: 

1. Highlighting the entire first column 

2. Right clicking on the top column header 

3. Select Format Cells… 

 

 

The Format Cells dialog box will appear. Select 

Custom, and then scroll through the type until you see 

mm/dd/yyyy hh:mm. Highlight it, and hit OK. 

Once you have formatted the spreadsheet, save it as a 

“CSV (Comma delimited) (*.csv)” file. 

 

  

The file is now ready to be imported into iChart. 

 

To input the data, in the main instrument control screen 

(the screen where you can see the Setup, Calibrate, and 

Interrogate buttons) select File | Import. 

The Import Data dialog box will appear. Browse to the 

spread sheet file, select it, and click Open. 
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A warning message will appear on the screen. Make sure you have selected the right file and 

click Yes. 

 
 

When the data has been successfully imported a message will appear. This may take a few 

moments depending on the amount of data being imported. 

 

 
 

Click OK and the data should now be in your database. 
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5.6 Posting Data to the Internet 

Most new environmental monitoring projects now require access to sensor data through an 

Internet datacenter.  Unfortunately, this component is usually difficult to develop due to the lack 

of web-enabled features and capabilities in many of the environmental sensors and dataloggers 

available on the market today.  Before iChart, many organizations had to hire expensive outside 

consulting services to develop a web interface for their systems. 

NexSens iChart software contains an integrated web posting tool – WebDB – that can take data 

stored in an iChart database and automatically upload it to a web server.  Your “Datacenter” is 

accessible online through NexSens’ data hosting service at http://www.WQData.com.  iChart 

users who choose to host data online can access it by logging into WQData.com with their 

username and password.   

New licenses of iChart software include a limited, one-year trial account to host data at 

www.trial.WQData.com.  Posting data to WQData.com is the easiest and fastest way to make 

your data accessible over the Internet.  No web development or outside consulting is required.  

NexSens has already developed the web interface for you and it can be used to display data in 

tables and graphs, and to download data in CSV format for use with popular spreadsheet 

programs.  The only requirements are iChart software and a PC with a real-time connection to 

the Internet. 

Configure WebDB to Upload Data to WQData.com 

iChart can begin posting data to WQData.com as soon as a device has been added to the 

database.  To enable WebDB, select the WebDB command from the File Menu. 

 

The Username field is the name 

that the running version of iChart is 

registered under. Type your 

password in the Password and 

Confirm Password fields.  If you 

have not setup an account at 

WQData.com and wish to use your 

free trial account, create a new 

password here. 

Select a web host from the Web 

Host drop-down box.  If you have 

an account setup, select 

WQData.com from the list. 

Otherwise, use the free trial 

account, select 

Trial.WQData.com. 

 

Type the name of your company or organization in the Company field.  This will be displayed 

when you login to your online “Datacenter” at WQData.com.  Enter your company’s message or 

tagline in the Message field.  This information, along with the Link Text/URL field will be 

displayed the main pages of your WQData.com website. It is a good idea to enter in your 

company information, as well as a link to your companies website, into these categories. 
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Under the Contact section, enter in your contact information. This information will be stored in 

your WebDB database. 

Click OK to create your online datacenter and export your current database to the web server.  

If you are using WQData.com, you can access your datacenter online at 

http://www.WQData.com.  Otherwise your data will be available online at 

http://trial.wqdata.com  

Note: you cannot click OK or go to any other tabs until all fields are filled in. 

Setting an Internet Data Posting Schedule 

By default, WebDB will post new data to your online datacenter once every 60 minutes, on the 

top of the hour.  You can change this schedule by selecting the Schedule tab in the WebDB 

Setup dialog box. 

 

To disable auto WebDB posting, uncheck the Enable Auto WebDB Posting box. This box is 

only checked if the account setup is successful. 

 You can still manually post to WebDB if this option is turned off. 

Select the days of the week and time interval during which WebDB will post data, or you can set 

up to four specific times when WebDB will post data each day.  Specify an offset (in seconds) if 

you need to wait for sensors to finish warming up before posting data. 

Click OK once your schedule is finished to activate it.  WebDB will begin posting new data to 

your online datacenter on this schedule. 
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Troubleshooting WQData.com Connection Problems 

 

From time to time customers experience issues related to connection problems between the 

WQData.com server and iChart running on a PC. 

These issues are usually the result of a client side firewall blocking traffic between the PC and the 

WQData.com server. When a WQData.com account is created three xml files are created on your 

computer. Once created, these files are uploaded via ftp (file transfer protocol) using port 21. 

When the upload is complete, a php script is invoked on the server side by the PC running 

iChart, using http protocol on port 80. All actions and results of that script are performed on and 

to the server side and does not do anything to the PC running iChart.  

These scripts simply use the three xml files to create a WQData.com database, create a table for 

the database to be filled with data, and then deposit data to the table in the database 

All data is transferred to trial.wqdata.com and redirected to the www.nexsensdatacenter.com 

domain. 

Another item to check before creating any WQData.com account or uploading data to your 

WQData.com database is internet connectivity. Open a web browser program such as internet 

explorer and go to www.wqdata.com. If the website loads correctly then your internet 

connection should be working. 

Typically, the problem resides in the fact that IT staff or a personal firewall are blocking ftp 

communication, port 21, or http php scripts, port 80. Check with your IT staff on whether or not 

this will be a problem with your computer. 
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5.7 Moving To Another Computer Or Backing Up Data 

In some instances it may become necessary to copy your iChart database to a different 

computer.  This process is extremely simple and is done by selecting the Backup command 

from the File Menu. From time to time you may also want to backup your iChart database to 

another location, other than the computer running iChart, in case of an emergency.   

Database Backup Process 

 

Select a destination folder for your backup database in 

the To field.  This should be a floppy disk, network 

folder, USB drive, or other location.   

Select None to disable the automatic backup schedule 

and choose to backup All data in the database.   

Click the Backup Now button to backup your iChart 

database to the specified location.  

 

 

Database Restoration Process 

 

Install iChart software on your new PC.  Once the 

installation is complete, start the program and select 

Restore from the File Menu. 

Enter the location of your backup IDB or ICR file in the 

From field.   

Click the Restore Now button to restore your 

database on the new PC.  The files will be restored to 

iChart’s “Users” folder located in (default): 

 C:\Program Files\NexSens\iChart6\Users\ 

 

 

Your data will now be accessible on the new PC.  Open the database by selecting the Open 

Project command from the File Menu.   
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6 Reference Guide 
6.1 Main Project Window 

This section describes the components and functions contained within the Main Project 

Window in iChart software. 

 

Title Bar 

The Title Bar displays the filename of the open iChart database. 

Menu Bar 

Many of iChart’s core features and functions can be accessed through the Menu Bar.  More 

information on specific program functions in the Menu Bar can be found in Section 6.6 – Menu 

Commands. 
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Main Toolbar 

 

The Main Toolbar contains icons that provide single-click access to core program functions. 

 

New Project - Creates a new iChart database.  iChart will display the Add New Device 

wizard to help you setup the database. 

 

Open Project - Opens an existing iChart database. iChart will display the Open Project 

dialog box, where you can locate and open the desired database. 

 

Save – In Report Mode, saves the current report in HTML format.  In Basemap Mode, 

saves changes to the current basemap. 

 
Print – Prints the current iChart report or basemap. 

 
Navigation Panel - Toggles the Navigation Panel on and off. 

 
Tools - Toggles the right tool bar on and off.  

 
New Basemap – Creates a New Basemap and opens Basemap Mode 

 
Instrument Mode - Opens the instruments tools. 

 
New Report  - Creates a new report and opens the Report Tools 

 

Schedule Tasks - Schedule tasks that will occur automatically like remote 

interrogation and report posting. 

 

To PDF - In Report Mode, saves the current report in PDF format. This button is only 

enabled in Report mode. 
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6.2 Navigation Panel 

The Navigation Panel provides quick access to the three core 

modules within iChart software – Basemap, Instrument Control 

and Report.  The panel is divided into three sections, each 

representing one of these modes. 

Basemap – Lists all basemaps associated with the iChart 

database.  Click an item to open that basemap within iChart. 

Site – Lists all sites, sensors and dataloggers associated with the 

iChart database.    

Report – Lists all open reports associated with the iChart 

database.  Click a file to display that report within iChart. 

Global Sample Interval – Sets a uniform sample interval 

for all devices without internal logging memory in the iChart 

database. 

Auto-Interrogation Status – Pauses and resumes 

auto-interrogation of sensors.  A green icon indicates 

auto-interrogation is active.  A red icon indicates auto-

interrogation is paused.  Click the icon to change its status. 

Interrogate All – Interrogates all devices in the iChart 

database. 

6.3 Instrument Control Screen 

The Instrument Control screen is one of the core components 

of iChart software.  Instrument Control provides a direct 

interface to all devices associated with the iChart database.  

Through Instrument Control you can set auto-interrogation 

schedules, manually interrogate devices, display the current 

days data, and more. 

This screen shows the most recent measurements retrieved 

from the instrument.  Each parameter is listed and their 

values are displayed in the green indicator boxes.   

Setup – Open the Device Property Dialog box.   

Schedule – Opens scheduling settings for power, 

interrogation and synchronization.   

Interrogate – Manually interrogates the device and retrieves 

any new data recorded since the last interrogation. 
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6.4 Device Properties – General Settings 

Click Setup from the instrument control screen to open the Device Property dialog box.  This 

screen contains various device configuration options.  All information is initially set while adding a 

device to the iChart database.  The Device Property dialog box can be used to update the 

device’s initial configuration. 

iSIC Tab 

 

Log Interval (min) – Displays the 

device Log Interval in minutes.  This 

field can be changed by entering a 

new value.  The minimum log interval 

allowed by iChart is one minute.  If 

you change the interval, click the 

Update iSIC button to set the interval 

in the iSIC.   

iSIC Time - Displays the time the iSIC 

is set to.  The time can be manually 

changed or can be synced to the PC 

time using the Set iSIC time to PC 

time check box.  If you change the 

time, click the Update iSIC button to 

set the time in the iSIC.   

 

iSIC Alarm Tab 

 

This tab is used to control the iSIC 

alarm functions.  Refer to section 5.6 

for more details.   
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Power Management Tab 

 

Continuous Power – Check this box 

to disable the power schedule and 

provide constant power to the 

NexSens 3100-iSIC Cellular Modem 

and 4100-iSIC Spread Spectrum 

Radio. 

Fix Time/Duration(min) – Check 

this box to power the iSIC at up to four 

different times for a duration you can 

set in the corresponding box for each 

time.  The duration is set in the 

minutes.   

Periodic – Check this box to power 

the iSIC for any interval set in 

minutes.  Again the duration can be 

adjusted for purpose and is set in 

minutes.   
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6.5 Device Properties – Interrogation Schedule 

Click the Schedule button from the instrument control screen to open the scheduling dialog box.    

 

Sun, Mon, Tues, … , Sat – iChart will automatically interrogate the device on the days 

indicated here.  Select every box for daily device interrogations. 

Every ? Minutes – iChart will automatically interrogate the device one time during this interval.  

The default setting of 60 minutes will set iChart to auto-interrogate once an hour, at the top of 

the hour.  Set this field to 30 minutes for two updates an hour.  Setting it to 15 minutes will 

provide four updates each hour.  The minimum value for this interval is one minute. 

Between ? and ? – iChart can be prevented from automatically interrogating the device outside 

the hours set in these fields.  Leave these fields at their default value to allow auto-interrogation 

at all times. 

At – If this option is enabled, iChart will auto-interrogate only at the times indicated here. 

Offset (sec) – An offset can be entered in this field to force iChart to wait a certain number of 

seconds before interrogating a device.  This option is typically used when the iChart database 

contains sensors that require a certain amount of time to “warm-up” before taking 

measurements. 

Fix Time/Duration(min) & Periodic – This option is available when the current device is 

connected to a NexSens 3100-iSIC Cellular Modem or 4100-iSIC Spread Spectrum radio.  This 

feature will program the iSIC to apply power to its cell modem or spread spectrum radio only 

during the time indicated in the Power-On Time and Duration fields. This option is used as a 

means to conserve battery life, as both the radio and cell modem draw a high amount of current.  

CAUTION!  Communication to the sensor will not be possible during the period of time when the 

cell modem or spread spectrum radio is powered down.  You must wait until the iSIC has re-

applied power before attempting to interrogate the sensor. 
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Sync RTC Schedule Tab 

 

The Sync RTC Schedule is the 

interval iChart will automatically sync 

the iSIC clock with the PC clock. As 

with any embedded device, the iSIC 

clock can drift as much as two minutes 

per month. Especially where power 

scheduling is implemented, making 

sure the iSIC time and the PC time are 

the same is important.Auto-Sync to 

PC Clock – Check this box to 

automatically sync the clock in the 

NexSens iSIC Datalogger with the PC 

clock.  Please exercise Caution when 

using this function.  Syncing your PC’s 

clock with a datalogger in a different 

time zone could create confusion and 

cause problems. 
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6.6 Instrument Control Tools 

Click the Edit icon  while in the Instrument Control screen to open the Instrument 

Control Tools.  These tools are used to customize the display of data in the Instrument Control 

screen. The options change based on which mode you are in. You can change modes by simply 

clicking on the corresponding tab. 

Text Color – Sets the text color for the most recent data points 

displayed in the Instrument Control’s Device Mode. 

Back Color – Sets the background color for the recent data status 

boxes displayed in the Instrument Control’s Device Mode. 

Alarm Color – Sets the status box background color to be 

displayed when an alarm is triggered for that parameter. 

Parameter Per Column – In some cases a device or datalogger 

may be configured to monitor a large number of parameters.  Use 

this field to display the most recent data points in multiple columns 

in Instrument Control’s Device Mode. 
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6.7 Report Tools 

The report tool bar is shown in the report screen on the right hand side.  The tabs are located at 

the bottom of the panel.   

Time Limit 

All – Includes all data from the iChart database in the report.  

Daily – Includes all data from the selected day in the report. 

Monthly – Includes all data from the selected month in the report. 

Yearly – Includes all data from the selected year in the report. 

From To – Includes all data between the selected dates in the 

report. 

Include 

Reports generated by iChart may include a project summary, data 

statistics, graphs, and data tables.  Place a check in the boxes to 

include these components in the report.   

Statistics – Displays a Statistical Summary for each parameter in 

the report.  Includes number of samples, average value, minimum 

value, maximum value, and the standard deviation for each 

parameter. 

Graph – Generates separate data graphs for each parameter and 

displays them within the iChart report.   

Data – Display data for each parameter in table format. 

Summary – Displays a Summary within the iChart report. 
 

Settings – iChart has addition settings in the Report Summary dialog box that appears once 

this Settings button is pressed.  This is used to decide what information is displayed in the 

summary when included in the report.   

All fields in this dialog box will show the text entered in the corresponding place in the report.   

Show detail field note – If you do not wish to see field notes on reports, uncheck this check box. 

This option is checked by default. 
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Time Resolution  

 

iChart allows you to auto-align data based on time. This feature is 

very useful when generating reports using multiple sensors that do 

not necessarily have the same time interval between data points. By 

default, no data alignment is selected. If you would like to align data 

to minute intervals, simply select UserDefined and enter the 

number of minutes you would like to align the data to. 

Parameter   

 

Place a check mark next to each parameter you want to include in 

the report.  Reports can contain data from all parameters.  By 

default, iChart will not select any parameters.  To display 

parameters, click the folder icon next to the device name and place 

a check next to the parameters you wish to view. 

 

Graph  

 

iChart incorporates an advanced feature allowing the user to place 

multiple traces on a single graph. This feature is very useful when 

comparing multiple parameters together to determine a correlation. 

Up to 12 traces per graph may be combined. iChart will 

automatically place the y-axis onto the graph for each additional 

trace as well as re-color any traces to avoid two traces having the 

same color.  

By default, the graph will display lines in between missing data 

points. The Disjoint Graph option allows you to show gaps in the 

graph where there are missing data points. 

 

This feature is even further enhanced by the Combine same parameter Y-axis button. If 

there is a check next to this field then iChart will combine the y-axis of each trace in the graph 

and redraw the trace as needed to fit this new y-axis. You will notice that when graphing 

multiple parameters together you will see multiple Y-axis on the graph, each one scaled to fit the 

parameter it is for. When you have the box checked it will set all the parameters to use the same 

axis. This makes it easier to numerically compare two graphs. (Note: this feature only works for 

parameters of the same type) 
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Graph Property Tab 

Click the Graph Property tab on the bottom to display options for customizing the look and feel of 

the graphs included in your iChart data report. 

Parameter  

Select a parameter from the list to customize its corresponding 

data graph.  Graphs are configured independently from one 

another, and changes made to one graph will not affect the 

appearance of any others. Only parameters that have been 

checked in the General tab parameters list will show up here. You 

can deselect a parameter by un-checking its corresponding check 

box. 

Note: If you would like to modify multiple parameters at a single 

time, you can select the folder they are in. Doing so will affect 

every device in that folder. You can also select the Site to modify 

every device in that site. 

Graph Scale 

Autoscale – Enable auto-scaling of the graph for the selected 

parameter. 

Lower Limit – Lower y-Axis limit for the graph of the selected 

parameter. 

Upper Limit – Upper y-Axis limit for the graph of the selected 

parameter. 

Graph Appearance 

Back Color – Background color for the graph of the selected 

parameter. 
 

Trace Color – Trace color displayed on the graph of the selected parameter. Note: If multiple 

parameters are on a single graph then iChart will make sure that two traces never have the 

same color. If you select a color for a trace that is already being used iChart will automatically 

change the color of that trace. 

Grid Color – Grid color displayed on the graph of the selected parameter. 

Trace Width – Trace width on the graph for the selected parameter. 

Graph Property 

Note: The first parameter from the Parameter menu must be selected.  

The text entered into these text boxes changes the text at the top of the report graphs. By 

default the X Axis Label is ‘Date’ and Title line 1 is the name of your iChart database. 
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Output Tab 

iChart reports can be output in a number of different formats and sent to a variety of locations.  

Auto Report options are available to send reports to the screen, printer, email, FTP server, 

printer or a folder on your PC or LAN.  Reports may be output in CSV, PDF, and IDB (iChart 

Database Backup) format. 

Enable Auto Report – must be checked for auto reports to be generated. 

Destination 

Display – Displays reports on your PC’s screen when they are 

created. 

Email – Sends reports to the specified e-mail addresses. 

FTP – Sends reports to the specified FTP server. 

Folder – Sends reports to the specified folder.  This folder may be 

located in either a local PC or LAN folder. 

Printer – Sends reports to your PC’s default printer. 

Format 

CSV – Saves reports in CSV format. 

PDF – Saves reports in PDF format. 

IDB – Saves reports in IDB (iChart Database Backup) format.  

Reports generated in IDB format may be opened directly in iChart 

with the Import command in the File Menu.   

Use Fixed Filename – If you wish to use the same filename every 

time iChart saves a report, enter it here.  iChart will overwrite 

previous reports generated with this filename.   

Auto-Report Schedule 
 

Day – Place a check next to each day you would like auto reports generated 

Every ? minutes – used to generate periodic reports. The value in this field is how often iChart 

will generate a report. 

Between ? and ? – iChart can be prevented from updating reports outside the hours set in these 

fields.  Leave these fields at their default value to allow report updates at all times.  

At –If this option is enabled, iChart will update reports only at the times indicated here.  

Offset (sec) – An offset can be entered in this field to force iChart to wait a certain number of 

seconds before updating a report.  This option is typically used when the iChart database 

contains sensors that require a certain amount “warm-up” time before taking measurements. 
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Advanced Tab 

Parameter 

Select a parameter from the list to configure its advanced options.  Changes made to one 

parameter will not affect the settings of any others. You can change multiple parameters by 

selecting the folder those parameters are in. Changes will then affect every parameter in that 

folder. 

Precision  

Sets the number of decimal places for the data shown in statistics, 

graphs, and data table.   

Output 

Avg – Check this box to display average values in the report.  The 

Time Resolution field in the General settings of the Report Tools 

determines the average values. 

Min – Check this box to display the minimum value that occurred 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Max – Check this box to display the maximum value that occurred 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Std – Check this box to display the standard deviation of the values 

recorded during the time period defined in the Time Slice field in 

the General Settings of the Report Tools. 

Sum – Check this box to display the sum of the values recorded 

during the time period defined in the Time Slice field in the General 

Settings of the Report Tools. 

Samples – Check this box to display the number of samples 

recorded during the time period defined in the Time Slice field in 

the General Settings of the Report Tools. 
 

Include Data 

The Value Limit filters the data sets to be displayed in the report.  A data set includes a 

date/time stamp, and the selected parameters from the General Settings tab of the Report 

Tools.   

All – Display all data. 

X <= ? –  Filter (Do Not Include) data sets above the indicated value. 

X >= ? – Filter (Do Not Include) data sets below the indicated value. 

? <= X <= ? – Filter (Do Not Include) data sets outside the indicated values. 
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Graph Markers 

iChart allows you to mark eight time events on your graphical reports. Click the More button to 

access the additional markers. Select the time and date from the Mark Time drop down menu 

and enter the text you would like displayed next to the mark in the Mark Text text box. This 

feature is extremely useful in marking times when the system was calibrated or offline for a 

period of time.  
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6.8 WebDB – Internet Data Posting 

WebDB is an advanced feature that can automatically post an iChart database to WQData.com – 

a NexSens online data hosting service.  WQData.com is an online interface that provides access 

to data retrieved from environmental monitoring sensors through standard web browsers like 

Internet Explorer and Netscape Navigator.   

Benefits of Internet data hosting at WQData.com include: 

� Information from multiple monitoring sites can be viewed from any PC with an Internet 

connection. 

� Users who do not have access to the iChart PC can still view data through their web 

browser. 

� Data can be shared quickly among colleagues through the Internet. 

� Data can be displayed data in graphs, plots, or simply downloaded to a PC in comma-

delimited (CSV) format for use with popular data analysis tools. 

� Access to data is provided 24 hours a day, 7 days a week. 

Each new license of iChart software includes a one-year trial account for storage of and access to 

environmental sensor data at WQData.com.  Please contact NexSens Technology, Inc. or visit 

http://www.WQData.com for more information. 

To enable Internet data posting in iChart, select WebDB from the File Menu.  The WebDB 

Setup dialog box will appear. 
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Edit/Remove Area or Site Map 

iChart allows you to upload custom basemaps to your WQData website. Base maps are easily 

created with custom images and controls that come pre-made in iChart and only need to be 

positioned on the screen. Thermometers, wind dials, and digital read outs are only a few of the 

controls available.  It should be noted that no artistic talent or programming required when using 

these features. 

Using WebDB, you can set area and site maps for your WQData database. Simply select either 

Edit area map or Edit site map and the from the WebDB menu  and the Basemap window 

will open. 

This basemap window is functionally the same as the normal basemap view except that instead 

of being able to create links to reports or other basemaps, you are able to create links to sites or 

areas on your WQData website. See section 6.5 Basemap Tools for more information. 

One further difference is that these basemaps are not available in the main instrument screen, 

and are only accessible through this menu. 
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Setup 

The Setup tab is used to configure the basic Internet data posting settings.  Click OK to save all 

changes and export your database to WQData.com. 

 

Account 

Choose password – Type the password associated with your WQData account into this field.  If 

you do not have an account at WQData, type a new password in this field. Confirm the password 

in the Confirm Password field. 

Web Host – Select a web host from this drop-down menu.  If you have an account setup at 

WQData.com, select WQData.com from the list.  If you do not have an account, select 

trial.wqdata.com.  User host should only be selected when using a web host other than 

WQData.com 

Website Header / Links 

Company – This field and it will be displayed at the top of your datacenter. 

Message – In this field you can configure your datacenter hosted at WQData to display a 

corporate message, tagline, project description, or other information on the page’s header.  

Contact 

Full Name – Contact name to be stored in WQData database. 

Email – Contact email address to be stored in WQData database. 

Phone – Contact phone number to be stored in WQData database. 
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Schedule 

 

Use the Schedule tab to setup an 

automatic Internet data posting 

schedule in iChart.  WebDB will 

upload new data added to your 

iChart database based on the 

schedule defined here. 

Note: You can manually post data 

by selecting File | Send To | 

WebDB. 

 

Enable Auto Webdb Posting – If unchecked, iChart does not automatically make Webdb postings. 

This option is not checked by default. It will however, be automatically be turned on after iChart 

has successfully setup up a WebDB account. 

Sun, Mon, Tues, … , Sat – WebDB will update the online database with new information on the 

days indicated by these check-boxes.  For daily downloads, select every box. 

Every ? Minutes – WebDB will post new data to your online datacenter one time during this 

interval.  The default setting of 60 minutes will set WebDB to upload data once an hour, at the 

top of the hour.  Set this field to 30 minutes for two updates an hour.  Setting it to 15 minutes 

will provide four updates each hour.  The minimum value for this interval is one minute. 

Between ? and ? - WebDB can be prevented from uploading data outside the hours set in these 

fields.  Leave these fields at their default value to allow data posting at all times. 

At – If this option is enabled, WebDB will update the online database only at the times indicated 

here. 

Offset (sec) – An offset can be entered in this field to force WebDB to wait a certain number of 

seconds after the time set before updating the online database.  This option is typically used 

when the iChart database contains sensors that require “warm-up” time before taking 

measurements. 

Re-post data from this time – This command is used to restore WebDB data posting when an 

iChart database is transferred to a new PC.  After restoring the database on a new computer, set 

this field to the date and time of the last WebDB data post.  
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Customize 

 

Many aspects of your online 

datacenter hosted at WQData.com 

can be customized to fit personal, 

corporate, or University 

requirements.  For example, colors 

and link text can be changed to 

match your organization’s standard 

themes.  Links to your home page 

and other sites of interest may be 

added to the datacenter. 

Theme 

Several Themes are included with 

iChart.  Select a Theme from the 

list to change the header image and 

color scheme of your online 

datacenter. 

The image at the top will automatically preview your WQData datacenter theme when a new 

theme has been selected.   

Color 

Banner – A custom image banner may be used with your online datacenter at WQData.com.  

This image’s dimensions must be 720 pixels long by 91 pixels high.  Once you have created a 

custom image for your datacenter, enter the file’s location into this field. 

Company text color – Select a color for the company text to be displayed over the header image 

of your online datacenter. 

Header band color – Select a color for the background color of the bar displayed immediately 

after the header image in your datacenter at WQData.com. 

Web link color – Select a color for the font color of all hyperlinks displayed in your online 

datacenter at WQData.com. 

Message text color – Select a color for the font color of your company message or project 

description. 

Footer color – Select a color for the footer displayed near the bottom of your online datacenter. 

Web Links 

Enter the names and Internet addresses of up to four websites in these fields.  Links to these 

sites will be displayed near the bottom of your online datacenter at WQData.com. The first 

website link can be modified from the Website Header / Links section of the WebDB Setup 

tab. 
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Host 

iChart gives users the option to host data at WQData.com as well as the choice to host data on a 

personal, corporate, or University web server.  These settings are only necessary when a web 

server other than WQData.com or Trial.WQData.com is used. 

If you plan to host your data on a personal web server, please contact NexSens’ technical 

support staff for instructions. 

 

Web Host – If “User host” is selected from the Setup tab window you will be able to modify the 

fields in this screen. This should only be used when using another web host other than 

WQData.com 

Web Host Detail 

FTP URL – Identifies the location of your WebDB folder.  For example, if your WebDB folder is 

located in the “Data” folder on your web server, type the following: 

http://www.mydomain.com/Data/ 

FTP login name – Enter name used to login to your FTP server. 

FTP password – Enter the password used to login to your FTP server. 

Confirm password – Confirm the password entered above. 

FTP folder – If you choose to store your database in a folder with a different name than 

“webdbxml” enter the new folder name here. 

MySQL host – If your MySQL database is located on a different server than your web server, 

enter the server name for the MySQL database.  If the database is stored on the same server, 

set this field to “localhost” or the server name. 
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Information 

 

iChart allows you the unique feature 

of adding information pages for 

your monitoring area’s sites. 

Monitoring Area – Select the iChart 

monitoring area you would like to 

add an information page to. 

Monitoring Site – Select the site you 

would like to attach the information 

page to. 

Title – Internet page title bar name. 

Picture – Image displayed before 

information text on your 

information page. Click Browse 

and select an image saved on your 

computer that you would like to be 

displayed. 

Information Text – Text to be displayed on your information page. 

External Link - Redirects the information page to the web address entered. 
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Advanced 

 

This feature enables multiple iChart computers to post data to a single database. This should be 

used with caution, as incorrect settings can ruin a Webdb database. Please contact Nexsens 

Technology Support staff before modifying and fields in this tab. 

 

iChart Monitoring Network 

Area ID – Enter the number of the “Monitoring Area” that the PC will belong to.  All iChart 

computers belonging to a specific Monitoring Area must have the same Area ID number. 

Area Name – Enter the name of the “Monitoring Area” that the PC will belong to.  All iChart 

computers belonging to a specific Monitoring Area must have the same Area Name. 

Site ID – Enter the number of the “Monitoring Site” that the PC will belong to.  Each iChart 

computer should have a unique Site ID.   

Site Name – Enter the name of the “Monitoring Site” that the PC will belong to.  Each iChart 

computer should have a unique Site Name. 

Site Info Link – Enter the URL of the HTML page that provides information about the Monitoring 

Site.  If no URL is entered, the web interface will use a blank template page. 

Use Shared WebDB Database – Check this box when your PC is part of a monitoring network 

with multiple PC’s posting data to a single shared online database. 

Setup local account only – Check this box to allow a new iChart computer to post data to an 

existing web database.  
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6.9 Basemap Toolbar 

 

The Basemap Toolbar is activated when the Tools icon is selected in 

Basemap Mode.  The toolbar can be hidden or shown using the Edit button 

 in the main toolbar.  These drawing tools will aid you in creating a 

custom basemap.   

 

 

The first group of tools are ready to be used as soon as they are placed and 

consist of shapes and lines. 

 

The next group are free hand drawing tools to allow you to customize any 

other option.  

 

The remainder of the tools aid in functionality and effect how the objects are 

oriented and how they look. 

 

 

There are four different kinds of basemap tools: Drawing Components, Display 

Components, Control Components, and Basemap and Component Properties. 
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6.9.1 Drawing Components 

 Select Object – used to select items on the basemap and adjust their properties. 

 Freehand – create freehand drawings on the basemap with customized colors. 

 Line – create freehand lines to be placed on the basemap with customized colors. 

 Polyline – create a freehand series of angled lines to be placed on the basemap with 

customized colors. 

 Rectangle – create freehand-scaled  rectangles to be placed on the basemap with 

customized colors. 

 Rounded Rectangle – create freehand-scaled rectangles with rounded corners to be placed 

on a basemap with customized colors. 

 Ellipse/Circle – create freehand-scaled circles to be placed on the basemap with customized 

colors. 

 Polygon – create a freehand-scaled, closed series of lines to be placed on a basemap with 

customized colors. 

 Text – enter text to a basemap. 

 Vertical Mirror – mirror an object vertically. 

 Horizontal Mirror – mirror an object horizontally. 

 Rotate Counter CW – rotate an object counter clockwise 90 degrees. 

 Rotate CW – rotate an object clockwise 90 degree. 

 Bring to Front – This button will make the selected object appear on top. 

 Send to Back – This button will make the selected object appear on bottom. 

6.9.2 Display Components 

 Read Out – this device places a LED data screen on the basemap, which will display data. 

 Chart – this device displays data in a chart form. 
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 Thermometer – places a thermometer on the basemap to analyze data in a more user-

friendly way. 

 Tank – places a tank on the basemap to analyze data in a more user-friendly way. This 

component displays data in a fuel tank fashion and is handy to use for water level, battery 

voltage, etc. 

 Half Gauge – places a dial on the basemap to analyze data in a more user-friendly way. The 

dial can represent numerous factors: speed, heat, pressure, etc. Data is measured from zero 

degrees to one hundred and eighty degrees.  

 Full Gauge – places a dial on the basemap to analyze data in a more user-friendly way. The 

dial can represent numerous factors: speed, heat, pressure, etc. Data is measured from zero 

degrees to three hundred and sixty degrees. 

 Percent – places a percent bar on the basemap to analyze data in a more user-friendly way. 

The percent bat can represent numerous factors, speed, heat, pressure, etc. Data is measured 

from zero percent to one hundred percent. 

 Wind meter – places the wind meter on the basemap to analyze data in a more user-friendly 

way. 

6.9.3 Control Components 

 Background Image – an image can be selected to display as the basemap. Click on this icon 

and then select the file location of the image. Changes made to the original image will not be 

updated on the basemap until the image is reselected as the Background Image. 

 Data Component – these are placed on basemap at certain locations, and when clicked on, 

you will move to a user-specified location in the data analysis. 

 Image viewer – places a view box on the basemap that acts as a slideshow. 

6.9.4 Basemap and Component Property 

 Fill Color – users select the color for all solid objects including rectangles, rounded 

rectangles, circles, and polygons. 

 Line Color – users select the color for all line objects including lines, pencil marks, and poly 

lines. 

 Font Color – users select the color for the font. 

 Background Color – users without basemap images can select the swatch color of the 

basemap. 
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 Line Thickness – users select the thickness of lines on objects. 

 Line Style – users select the style of the lines on objects. 

 Font – users select the adjustment of scale in text. 

 Toggle Grid – displays a grid over the basemap. 

 Grid Property – locks a grid to the basemap for manipulation of objects, 

 Redraw – refreshes the basemap if a pause in data analysis has taken place. 

 Magnify – magnifies a selected area of the basemap. 
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6.10 Menu Commands 

6.10.1 File Menu 

New Project – Creates a database. iChart displays a menu to 

help you setup your first database. 

Open Project – Launches an existing database. iChart displays 

the Open dialog box in which you can locate and open the 

desired file. 

Close – Closes the open iChart database and along with all 

associated reports and basemaps. 

Save – In Report Mode, select this command to save the current 

report in HTML format.  In Basemap Mode, select this command 

to save the current basemap. 

Set Project ID – See Section 6.16 for more details.   

WebDB – Setup WebDB or specify WQData basemaps. See 

section 7.4 for  more details.   

Operating Mode – Choose to run iChart in server, client or the 

default stand-alone mode. See Section 7.15. 

Backup – Opens the Backup Data dialog box.  

Restore – Opens the Restore Data dialog box.  

 

 

Import – Imports data from a .CSV file into the open iChart database.  Caution: Once data has 

been imported into the iChart database it is not possible to remove it.  This action also will 

overwrite existing iChart data points that have identical date/time stamps in the .CSV file.  . 

Export – Exports the open iChart database to a .CSV file. 

Send To – In Report Mode, this command sends a report to an e-mail recipient, FTP server, 

folder, or Microsoft Excel. You can also use this command to manually update your Webdb 

database. See Section 7.14.6 for more information. 

Print – In Report Mode, select this command to print the current HTML report. 

Print Preview – In Report Mode, select this command to preview the output of the Print 

command. 

Print Setup – Select this command to configure specific printer settings. 

Recent Databases – A listing of the four most recent iChart databases is displayed near the 

bottom of the File Menu.  Click a database listed here to open it in iChart. 

Exit – Exit iChart software. 
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6.10.2 Edit Menu 

Undo – Select this command to undo the most recent iChart 

action.  

Redo – Select this command to redo the last undo in iChart. 

Cut – Select this command to cut an object and place it on the 

clipboard. 

Copy – Select this command to copy an object and place it on the 

clipboard. 

Paste – Select this command to paste an object from the clipboard 

into iChart. 
 

Preferences – Open the System Setup dialog box. See Section 7.14.3 for more information. 

6.10.3 View Menu 

Main Menu – Select this command to toggle the display of the Main 

Menu. To display the main menu once it has been toggled, hit the ‘esc’ 

key.  

Main Toolbar – Select this command to toggle the display of the Main 

Toolbar. 

Status Bar – Select this command to toggle the display of the Status 

Bar. 

Basemap Tools – Select this command to display the Basemap Tools. 

Report Tools – Select this command to display the Report Tools. 

Instrument Tools – Select this command to display the Instrument 

Control Tools. 

 

Navigation Panel – Select this command to toggle the display of the Navigation Panel. 

Diagnostic Window – Select this command to display iChart’s Diagnostic Window.  The 

diagnostic window is an advanced tool used by NexSens technical support staff for 

troubleshooting purposes. 

Full Screen – Select this command to toggle Full Screen mode in iChart.  Full Screen mode will 

maximize the iChart program window and hide all top line Menu Commands. 

6.10.4 Basemap Menu 

New Basemap – Select this command to create a new basemap for 

the open iChart database.  

Remove Basemap – Select this command to open the Remove 

Basemap dialog box.  Select a basemap from the list and click the 

Remove button to delete the basemap from the iChart database. 
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6.10.5 Project Menu 

Pause Auto-Interrogation – When auto-interrogation is 

enabled, pauses auto-interrogation of devices in the iChart 

database.   

Unpause Auto-Interrogation – When auto-interrogation is 

paused resumes auto-interrogation of devices in the iChart 

database.   

Clear Warning Message – Clears the Auto-Interrogation 

Failed warning message. 

Setup Device Wizard – Open the Device Wizard dialog box.  See 

Section 4 Adding Devices for more information. 

Setup iChart Alarm – Open the iChart Alarm dialog box.  See 

Section 5.7 Setting Up and Using iChart Alarms for more 

information. 

Setup Device – Open the Device Property dialog box.   

Setup Schedule – Open the Setup Device dialog box. See Section 5.5 for more information. 

Interrogate – Interrogates the currently selected device. 

Interrogate All – Interrogates all sensors in the iChart database individually. 

ODBC – You can select to either open an ODBC database or create a new one. See section 6.3 

for more information. 

Add Field Note – Adds a field note to reports made with this database. 

Project Monitor – Opens System Monitor dialog box.  See section 5.8 Monitoring Critical 

Projects for more information.   

Sync all iSIC clock – Sync’s the clock of all iSIC data loggers in the current project. 

Property  - Opens the properties dialog box of selected device.    
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6.10.6 Report Menu 

New Report – Creates a new Report from data stored in the open 

iChart database.  

Open Report – Opens a previously created report associated with the 

current iChart database. 

Create PDF Report – In Report Mode, select this command to export 

the current report in PDF format.  This will generate a new PDF 

document that can be saved on your PC. 

Page Properties – Select this command to modify the settings of the 

PDF generator. 

Refresh Report – Refreshes the current report view. 

Other Setup – Opens Other Setup dialog box.   

Unit Tab – Used to change the units of each parameter available.   

Misc Tab – Contains addition settings to adjust.  Data display order, 

time limit mode and auto-report index options can be set here.   
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6.10.7 Advanced Menu 

Lock – Select this option to “lock” the iChart database and 

prevent unauthorized users from making changes to settings and 

devices. 

Set Password – Select this command to enable and set an 

administrator password for the open iChart database.  Users will 

be required to enter this password before any changes may be 

made to the database’s settings and configuration. 

System Check – Checks the status of all devices in the iChart 

database. 

iSIC – Select this command to access a sub-menu that contains 

special configuration and troubleshooting tools for NexSens iSIC 

dataloggers and telemetry systems. 

 

Sensor Interface – Select this command to access a sub-menu that contains special 

configuration and troubleshooting tools for various environmental sensors. 

Global Sample Interval – Select this command to set a global sample interval.  This action will 

set a uniform sample interval for all devices in the iChart database. 

Terminal – Opens an RS232 terminal to the currently selected device in Instrument Control 

Mode.  

6.10.8 Window Menu 

Cascade – Arranges all iChart windows (ie. Instrument Control, Report, 

Basemap) in a cascading pattern. 

Tile Horizontal – Arranges all iChart windows horizontally. 

Tile Vertical – Arranges all iChart windows vertically 

Open Windows… - All open iChart windows are listed in the Window menu.  

Select an open window to switch between reports, basemaps, and instruments. 

6.10.9 Help Menu 

User’s Guide – Opens the iChart User’s Manual in PDF format. 

About iChart – Displays the About iChart dialog box.   

Check For Updates – Select this command to check for iChart 

software updates available at NexSens’ website. 

Register iChart – iChart can be used for 30 days on a free trial basis.  

During these 30 days all features are available.  Once the 30-day trial 

period is completed, your copy of iChart must be registered with 

NexSens.  Contact NexSens to register iChart today. 

 

NexSens Website – Select this command to open your web browser to go directly to NexSens 

website: http://www.NexSens.com 
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6.11 Advanced Dialog Boxes and Menus 

6.11.1 Backup 

The Backup command is used to make backup copies 

of an iChart database.  Backups can be scheduled for 

regular intervals or created manually.  Both the .ICR 

file and complete database are included in the 

backup.  This command is only available when an 

iChart database is open.  Backup is in the File menu.   

Project – Displays the name of the open iChart 

database. 

To – Enter the destination for your iChart database 

backup files.   

Backup Schedule 

None – Select this option to disable automatic iChart 

backups. 

Remind me to backup every – Selecting this option 

will cause a backup reminder to appear in iChart after 

a set number of days. 

 

Auto backup daily at – iChart will automatically backup your database every day at the time set 

in this field. 

Auto backup weekly on – iChart will automatically backup your database once a week on the day 

set in this field. 

Auto backup every – iChart will automatically backup your database once every specified 

interval. 

How Much Data to Backup 

Current Month – Select this option to backup the current month’s data. 

Current Year – Select this option to backup the current year’s data. 

All – Select this option to backup all data stored in the iChart database. 

Backup Now  

Click this button to backup the iChart database. 

Note: iChart automatically saves your iChart configuration every time a database is opened to 

folder: 

C:/Program Files/Nexsens/iChart5/Users/*.Backup.  

Where * is the name of your database. iChart only saves your configuration however, not your 

data. You must use the Backup feature in order to save the database data. 



NexSens Technology, Inc. 

iChart Software Operations Manual 85 

6.11.2 Restore 

The Restore command is used to restore an iChart 

database that has become damaged or is otherwise 

inaccessible.  This command is also used when 

transferring an iChart database from one PC to another.  

Restore is in the File menu.   

From – Enter the location of your iChart database 

backup files. iChart automatically saves your iChart 

database in a folder located at: 

C:/Program Files/Nexsens/iChart5/Users/*.Backup 

Where * is the name of your database. In this folder will 

be folders that have the name of a date (yy/mm/dd – 

hh/mm) iChart configuration was backed up. Simply, 

click on the date you wish to restore from and select the 

.icr file contained within the folder. 

 

Note: iChart only saves your database configuration in the .icr file. In order to back up your data 

you will need to manually back up your database with the Backup command.  

Restore Now – Click this button to restore your iChart database from the location specified in 

the From field. 
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6.11.3 System Setup 

 

Located in Edit | Preferences.   

General Tab 

 

Program Start 

Enable startup dialog – Enables the Open Choice Dialog window to open upon iChart6 startup. 

This item is checked by default. From the Open Choice Dialog window you can select how you 

want iChart6 to open every time it opens.   

Auto load project – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used upon iChart6 startup. 

Auto load basemap – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used and open to the basemap view upon iChart6 

startup. 

Auto load report – This option is only available if the Enable open choice dialog box is 

unchecked. iChart will open the last project used and open to the last report made upon iChart6 

startup. 

Display 

Time format – The format selected here will change the format everywhere it is seen in 

Instrument Control screen. This format will not, however, affect the way time is seen in 

reports. Select H:M to display hours:minutes, and selected H:M:S to display 

hours:minutes:seconds. 

Enable basemap rotation – Enables the Basemap view and Instrument Control view to be 

rotated. Each view will be displayed on the screen for the number of seconds specified. This 

option is ideal for displays in lobbies and other areas where you would like the viewers to be able 

to see different iChart screens. 
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Enable flash warning – Enables the Auto Interrogation Failed warning window to display 

whenever an auto interrogation fails. This box is checked by default. You can disable auto 

interrogations from the Setup menu in the main Instrument Control screen. 

Email Tab 

MAPI – Sets iChart to use 

MAPI email protocol when 

ever it needs to use email, for 

example when iChart 

automatically sends reports 

via email. The email options 

will need to be setup in their 

respective menus. Contact 

your system administrator or 

email service provider for 

information regarding which 

protocol you should be using. 

SMTP – Sets iChart to use 

SMTP email protocol when 

ever it needs to use email, for 

example when iChart 

automatically sends reports via email. The email options will need to be setup in their respective 

menus. Contact your system administrator or email service provider for information regarding 

which protocol you should be using. 

Advanced Tab 

 

COM Port Access 

Enable remote access – allows you to interface to iChart remotely via COM port.  

Enable pass through – allows you to interface to iChart using pass through mode via COM port. 

Data Replication 
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Enable – Enabling Data Replication allows you to save data in csv (Microsoft Excel) format. 

iChart will always save data in an iChart database files located in C:/Program 

Files/Nexsens/iChart5/Users/<iChart database file name>.Data.  

Include header – when using saving in another specified format, iChart can save the header 

information of that data into the new format. 

Format – This option allows you to select the format that you wish to save your data in. 

Folder – This option allows you to specify the folder which you would like the data to be saved in.  

Interrogation 

Broadcast iSIC close cmd – This option is for backwards compatibility. Use only when instructed 

to by Nexsens Technology Support Engineers. 

Enable Group iinterrogation – In order for group interrogation to work, this box must be 

checked. This is not checked by default, nor is it ever automatically checked by iChart.  

 

GUI Tab 

 

Enable Advanced Interface – This checkbox allows the user to enable or disable advanced 

interface.   

Readout per column – This option affects the number of devices shown in the main Instrument 

Control screen per column. The value in this box does not directly correlate to the actual 

number of devices shown, as iChart automatically evens each column out so that they align 

evenly. 

Application Skin – This option allows you to select the type of windows theme you would like 

iChart to display. Note: some themes may not look like that them if certain options in the 

windows operating system are not setup.  
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Retry Notification – Number of times iChart will retry communicating to a device before it will 

change the basemap read-outs and instrument screen time to red to signify the failed 

connection. 

     

Log Diagnostic Data – This checkbox allows the user to enable or disable logging diagnostic data.   

Minimize to System Tray – When checked, iChart6 will be displayed only in the system tray when 

minimized.   

6.11.4 Page Property 

Page Property allows you to setup features such as the paper size and other paper options. 

These features do not become displayed in iChart and will only affect printing options. You will 

need to have a report open to change the page property. These changes only affect the report 

that is open. If you would like to modify more than one report, you will have to do this 

individually.  This located in Report | Page Property.   

 

General Tab 

Margin 

When in html view, iChart will set the margins to the inches specified. This is just like margins 

set in Microsoft Word, etc. Margins should be chosen based on what looks the best on your 

printer. 

Page Break 

When in html view, iChart will automatically insert page breaks after certain events as specified. 

This is just like the page break in Microsoft Word, etc. Using page breaks allows you to keep 

sections of the report on individual pages, and generally makes the report look better. All page 

break options are enabled by default. 
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PDF Tab 

 

Page 

Size – Select the paper size you would like for PDF reports. This should be the actual size of 

paper you will be using to print the PDF report. 

Width / Height – If Custom is selected from the Size drop down menu, you will be able to enter 

in the actual Width and Height of the paper you will be using to print your PDF report. 

Page Orientation – Select the orientation you would like the pages of your PDF report to be 

printed. 

Font 

Scale – Allows you to scale up or scale down the font size of your PDF report by the percentage 

entered. 

Y-Axis Scale Orientation 

Sets the orientation of the Y-Axis scale labels on graphs generated in your PDF report. 
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6.11.5 Field Note 

 

The field note field is located in every report generated 

by the current database, as long as you have checked 

Summary to be displayed. This feature cannot be 

used when a report is open.  This is located in Project 

| Add Field Note… 

 

Time – The time to be displayed for the note. 

Type – The type of note to be displayed. There are many pre-made notes to insert. Or you can 

create your own by selecting Custom. 

Note – The text to be displayed for the note. 

 

6.11.6 Send To 

The ‘File | Send To’ feature allows you to send iChart data to other programs or other locations. 

WebDB 

 

Selecting File | Send To | WebDB allows you to manually post data to your WQData.com 

website.  

All data from last auto-post – will manually post data from the last time iChart posted data. 

Only data defined below – will manually post data from the data specified in the From field to 

the date specified in the To field.  A selection from the Device drop down menu must be chosen 

to pick which devices to post data from.  Also, a number of hours of data to be posted can be 

chosen in the Post text box.  Click OK when finished. 
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6.12  Using iChart in Server / Client Mode 

iChart can run in three different modes; Standalone, Client, or Server. By default, all iChart 

databases run in Standalone mode. 

 

You can easily change between modes by selecting the desired mode from File | Operating 

Mode.  

Setting up the Server Mode computer: 

To begin running iChart in Server mode, simply select Server from the Operating Mode list. 

This computer must be connected to a local network or internet. Once one computer is running 

in Server mode, other computers can properly run in Client mode. On another computer that is 

connected to the same network select Client from the Operating Mode list. A dialog box will 

appear asking for the server address. Enter the host name or IP address of the computer 

running in Server mode.  

 

One thing to be aware of is that by 

default iChart uses Port 22703 for 

Client/Server mode. If the server is 

running a firewall port 22703 must 

be allowed to be accessed. 

For example, if your computer is 

using the Windows Firewall, you can 

add the iChart Server port by going 

to Start | Control Panel | 

Windows Firewall in Windows. 

Then click on the Exceptions tab 

and click the Add Port button. Then 

add TCP port 22703 to the list. 

For added security you can click the 

Change Scope button and add only 

the IP addresses of the computers 

that will be running in Client mode. 

 



NexSens Technology, Inc. 

iChart Software Operations Manual 93 

Setting the sampling interval: 

 

After the database has been created and setup to run in Server mode, click on the clock icon at 

the bottom left corner of the Navigation Panel.  

 

In the Sample Interval field, enter the interval in seconds that you want to get a reading from 

the sensors. This reading will be updated on basemap readings and the main instrument display 

window.  

In the Log Interval field, enter the interval in seconds that you want to log a reading into your 

iChart database. 

Note: When using the Global Sample/Log Interval make sure to turn off auto interrogation. 

You can do this by clicking the Setup button on the main instrument control screen and then 

unchecking the Enable check box.  
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Setting up the Client Mode computers: 

Make sure that the client computers are using the same .ICR file that the server computer is 

using. You can easily ensure this by using the iChart Backup/Restore feature (see section 7.7 

Backup and Restore). Simply create an iChart database on the computer that will be running in 

Server mode. Then go ‘File | Backup’ in iChart, and backup the database to a network location, 

or thumb drive, CD, etc. Next go to the computer that will be running in Client mode and go 

‘File | Restore’ and specify the backed up database. 

Next go ‘File | Operating Mode’ and select client from list. Enter the IP address of the computer 

running iChart Server. 

 

Click OK and computer will now run in client mode.  

You should now set a sample and log interval. Click on the clock icon again at the left corner of 

the Navigation Panel. 

In the Sample Interval field, enter the interval in seconds that you want to get a reading from 

the server. This reading will be updated on basemap readings and the main instrument display 

window. 

In the Log Interval field, enter the interval in seconds that you want to log a reading from the 

server. This reading will be saved into an iChart database as if the sensors were connected to the 

client computer. 

Now that your database is running and getting readings, you can now utilize some of the 

features of iChart that will make an easy to view screen. For example client window, you could 

create a basemap, and then disable all of the menu systems to have a screen like this: 

 

See the basemap section of this manual for more information on setting up basemap displays. 
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6.13  Protecting an iChart Project 

When using remote telemetry options such as cellular and phone line, any computer running the 

same project file can access the data loggers and sensors in that project file. However, the 

project file may need to be shared among other people on other computers so that they can 

generate iChart reports, and view project data through iChart. In this case it is best if the project 

file is locked so that only the computer that created the project can interrogate devices, send 

system alerts, post data online, edit sensor configurations and data logger settings. To do this; 

simply select File | Set Project ID 

 

iChart will ask you if want to set the project ID of this iChart. 

 

iChart will then output the project ID of your computer. Write this 

ID down. In the case that the project file would later need to 

become unprotected so that other computers can interrogate 

devices, edits sensor configurations, etc, the project ID will be 

required. 

 

The next time File | Set Project ID is selected, iChart will ask 

for the current project ID. The project ID can be cleared 

(unprotecting the project file) by entering the project ID and 

putting a check in Clear Project ID. 

 

Features Protected: 

Add device 

Edit device 

Enable/disable device 

Remove device 

Calibrate 

Setup site 

Post wqdata 

Setup wqdata 

Interrogate device 

Execute SQL file 

Repost ODBC data 

Setup ODBC 

Open ODBC 

Add field note 

Setup parameter 

Sync iSIC clock 

New basemap 

Create/edit wqdata area 

map 

Create/edit wqdata site 

map 

Remove wqdata area map 

Remove wqdata site map 

System monitor 

Setup autosync iSIC clock 

Interrogate all 

Global sample interval 
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Appendix 
 

END USER LICENSE AGREEMENT ("EULA") 
  

NOTICE: Please CAREFULLY read this EULA. If you install or use this software product(s) 

(the "SOFTWARE"), you will be legally bound by this EULA. If you do not want to be bound 

by this EULA, you must promptly return the SOFTWARE and all accompanying 

documentations in the original packaging to the place where you obtained them for a full 

refund. If you do not accept this EULA, you may not copy, retain or use the SOFTWARE. 

  

1. LICENSE GRANT. (a) NexSens Technology, Incorporated ("NEXSENS"), grants you a non-

exclusive license to use the SOFTWARE, subject to the following: 

  

Except as stated below, you may install the SOFTWARE on only one computer. If the 

SOFTWARE can be used from any computer other than the computer on which it is installed 

(whether because the computer on which it is installed is part of a network or for any other 

reason), you must license a copy of the SOFTWARE for each computer from which the 

SOFTWARE may be used. 

  

If you are the primary user of more than one computer, you may install the SOFTWARE on 

each of them so long as the SOFTWARE is never used on more than one of the computers at 

the same time. If you want to allow the SOFTWARE to be used on more than one of the 

computers at the same time, then you must license a copy of the SOFTWARE for each 

computer. 

  

You may make a reasonable number of back-up copies of the SOFTWARE.  The back-up 

copies may be used only to replace an unusable copy of the SOFTWARE.  You must destroy 

any copies of the SOFTWARE that are replaced by a back-up copy. Back-up copies must 

include all proprietary rights and notices appearing on the original and must remain in your 

possession or control. 

 

You may, after written notification to NEXSENS, transfer the SOFTWARE on a permanent 

basis to another person or entity, provided you retain no copies of the SOFTWARE and the 

recipient agrees to the terms of this EULA.  If you have received an update to the 

SOFTWARE, any transfer must include the update and all prior versions of the SOFTWARE.  

  

Except as specifically permitted in this EULA, you may not (i) copy the SOFTWARE, (ii) 

modify the SOFTWARE or extract any of its components for use with other software (iii) 

decompile, disassemble, reverse engineer, or make any attempt to discover the source code 

of the SOFTWARE (iv) sublicense, rent, or lease any portion of the SOFTWARE.   

  

You may not allow anyone to do anything that this EULA prohibits you from doing. 

  

(b) You understand that the SOFTWARE is licensed to you and not sold. NEXSENS retains 

title to all copies of the SOFTWARE.  

  

2. LIMITED WARRANTIES AND DISCLAIMER OF IMPLIED WARRANTIES. (a) NEXSENS 

warrants that, for thirty (30) days after you obtain the SOFTWARE (the "Warranty Period"), 

(i) the SOFTWARE will perform substantially in accordance with the enclosed user 

documentation, and (ii) the disks or other media on which the SOFTWARE is distributed will 

be free of defects in material and workmanship. This limited warranty does not cover 
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anything caused by accident or abuse or by use of the SOFTWARE other than for its 

reasonably intended purposes and as recommended in the accompanying user 

documentation. Also, NEXSENS does not warrant that the operation of the SOFTWARE will 

be uninterrupted or error free. Furthermore, any written or oral information or advice given 

by NEXSENS distributors, agents, or employees will in no way increase the scope of this 

limited warranty.  This warranty gives you specific legal rights, and you may also have other 

rights, which vary from state to state.  

  

(b) Except as stated in Section 2(a), NEXSENS does not make any warranties. In particular, 

NEXSENS disclaims all implied warranties, including the implied warranties of 

merchantability, fitness for a particular purpose, and non-infringement. The duration of any 

implied warranty that is not effectively disclaimed will be limited to the 30 day Warranty 

Period. Some states do not apply limitations on how long an implied warranty lasts, so the 

above limitation may not apply to you. 

  

3. EXCLUSIVE REMEDIES. (a) If, during the Warranty Period, you report any breach of 

warranty to NEXSENS and NEXSENS is reasonably able to verify that breach, NEXSENS or 

its agent will, at its option, either (i) correct the SOFTWARE or replace any defective media, 

(ii) help you work around or avoid the problem, or (iii) allow you to return the SOFTWARE 

and all accompanying documentation in the original packaging for a full refund. If you 

return the SOFTWARE for a refund, you may not retain or use the SOFTWARE, and you 

must immediately destroy all back-up copies and any other copies of the SOFTWARE in your 

possession or control. 

  

(b) During the Warranty Period, you may report breaches of warranty by contacting 

NEXSENS Customer Service. You must describe the breach in detail and include a phone 

number or address at which you can be reached during normal business hours. NEXSENS 

will respond within a reasonable time to any reported breach. You must pay all costs of 

shipping any SOFTWARE or other materials. Any corrected or replaced software that you 

obtain under this EULA will be considered part of the SOFTWARE licensed under this EULA 

and will be covered by warranty only for any time remaining in the original Warranty Period. 

 

(c) The remedies stated in this Section 3 are your only rights or remedies, and will be 

NEXSENS's only liability or obligation, for any breach by NEXSENS of any warranty. 

 

4. PROPRIETARY RIGHTS. Subject to this EULA, NEXSENS and its licensors retain all 

copyrights, trade secret rights, patents, trademarks, and any other proprietary rights 

covering or relating to the SOFTWARE.  You acknowledge that the SOFTWARE includes or 

incorporates proprietary and confidential information belonging to NEXSENS and/or its 

licensors. All rights not expressly granted by NEXSENS in this EULA are reserved. 

 

5. EXCLUSION OF CONSEQUENTIAL DAMAGES; LIMITATION OF LIABILITY. Neither 

NEXSENS nor its affiliates nor its licensors will be liable for any special, incidental, 

consequential or exemplary damages, including without limitation damages for loss of use, 

lost profits or loss of data or information of any kind, arising out of or in connection with the 

SOFTWARE or its use or this EULA, even if NEXSENS or its affiliates or its licensor have been 

advised of the possibility of such damages. In no event will NEXSENS’s or its affiliates’ or its 

licensors’ liability for any claim relating to the SOFTWARE or its use or this EULA, whether in 

contract, tort or any other theory of liability, exceed the license fee paid by you. Some 

states do not allow the exclusion or limitation of incidental or consequential damages, so the 

above limitation or exclusion may not apply to you. 
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6. CAUTIONS REGARDING DATA. The SOFTWARE contains tools to be used in transmitting, 

searching, and retrieving data in various forms as described in the documentation. You 

assume the entire responsibility for determining the legality of any transmission or copying 

you may engage in and for protecting yourself, your business, and associates from any 

offensive or inaccurate data, information, or material you may choose to receive or allow to 

be transmitted to you.  NEXSENS does not grant any warranty with respect to, or assume 

any responsibility for any consequences whatsoever suffered by any person as a result of, 

your access or use of the Internet including, without limitation, access to or resulting in 

false, incomplete or unreliable data, computer viruses, or corrupted data. 

 

7. EXPORT. You acknowledge that the SOFTWARE is subject to United States export control 

laws, including the export administration regulations. You will not export, re-export or divert 

the SOFTWARE in contravention of those laws. 

 

8. TERMINATION. NEXSENS may terminate this EULA if you violate it. You must destroy all 

copies of the SOFTWARE in your possession or control promptly upon termination. Upon 

NEXSENS’s request, you must certify in writing that you have complied with your obligations 

under this Section 8 and otherwise under this EULA. Termination by NEXSENS will not limit 

any of its other rights or remedies under this EULA or at law or in equity. Any provision of 

this EULA that by its sense and context is intended to survive termination of this EULA will 

survive termination. 

 

9. SEVERABILITY. If any provision of this EULA is illegal or unenforceable under applicable 

law, the remaining provisions of this EULA will remain valid and fully enforceable. If any 

provision is in part enforceable and in part unenforceable, it will be enforced to the extent 

permitted under applicable law. 

  

10. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are 

provided with RESTRICTED RIGHTS.  If this product is licensed by any agency or 

instrumentality of the United States of America, use, duplication and disclosure are subject 

to restriction as set forth in subparagraphs (a) - (d) of the rights in Technical Data and 

Computer Software clause at FAR 52.227-19 or any successor regulation, or in subdivisions 

(c)(1) and (2) of the Commercial Computer Software Restricted Rights clause at 48 FAR 

52.227-7013 or any successor regulation, or as set forth in the particular department or 

agency regulations or rules which provide NEXSENS or its licensors protection equivalent to 

or greater than that clause.  The contractor/manufacturer is NexSens Technology, 

Incorporated, 1328 Parkway Ct Dayton, Ohio 45432. 

 

11. ENTIRE AGREEMENT. This EULA, together with any special rights or promotions provided 

in writing with your copy of the SOFTWARE, is the entire agreement between you and 

NEXSENS relating to the SOFTWARE.  It supersedes any prior or contemporaneous oral or 

written communication relating to the SOFTWARE. 

 

If you have any questions concerning this EULA, please contact in writing: NexSens Technology, 

Incorporated, 1328 Parkway Ct Dayton, Ohio 45432 


